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サイプレスはインフィニオン テクノロジーズになりました
この表紙に続く文書には「サイプレス」と表記されていますが、これは同社が最初にこ
の製品を開発したからです。新規および既存のお客様いずれに対しても、引き続きイン
フィニオンがラインアップの一部として当該製品をご提供いたします。

文書の内容の継続性
下記製品がインフィニオンの製品ラインアップの一部として提供されたとしても、それ
を理由としてこの文書に変更が加わることはありません。今後も適宜改訂は行います
が、変更があった場合は文書の履歴ページでお知らせします。
 
注文時の部品番号の継続性
インフィニオンは既存の部品番号を引き続きサポートします。ご注文の際は、データシー
ト記載の注文部品番号をこれまで通りご利用下さい。
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本アプリケーション  ノート  (AN75320) は、カスタム機能を実装できるプログラマブル デジタルとアナログ ブロックを内蔵した 

8 ビット プロセッサである PSoC
®

 1 を紹介します。本アプリケーション ノートは PSoC 1 アーキテクチャ、開発ツールおよび

初めての設計を作成する方法について説明します。本書はまた、PSoC 1 を迅速に深く理解できるように更なるリソースへの

アクセスを提供します。 
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1 はじめに 

PSoC 1 は、単一のチップ上にカスタム アナログとデジタル ペリフェラル機能、メモリおよび M8C マイクロコントローラーを集
積した、真のプログラマブルな組み込みシステムオンチップです。 

これは、マイクロコントローラー (MCU) と外部アナログ／デジタル ペリフェラルの組み合わせを使用するアナログ／デジタル
混在の組み込みシステムとは異なります。通常、このシステム タイプは MCUに加えて、オペアンプ、ADC、デジタル ASIC など
多くの集積回路を必要とします。 

PSoC 1 は、MCU と外部 IC の組み合わせの代わりに低コストのソリューションを提供しています。システム全体のコストを削減
する以外、プログラマブル アナログとデジタル サブシステムにより、設計の高い柔軟性、インフィールド チューニングおよび短い
製品化までの時間が可能になります。 

PSoC 1 のシステム リソースは、全く異なる機能を実行するよう実行中にダイナミックにリコンフィギュレーションすることが
できます。ダイナミックなリコンフィギュレーションは、リソースが設計に消費された場合にも可能です。これにより、PSoC 1 の
システム リソースを再利用し、集積能力を最大限に発揮させることができます。 

PSoC 1の CapSense
®という静電容量タッチ センシング機能は、比類のない信号対ノイズ比 (SNR) 、クラス最高の耐水性、

および多種多様なセンサー タイプ (ボタン、スライダー、トラック パッド、近接センサーなど) を提供しています。 

本アプリケーション ノートは、PSoC 1 のアーキテクチャおよび開発ツールを研究するのに役立ち、PSoC 1 の開発ツール
である PSoC Designer™を使用して初めてのプロジェクトを作成する方法を案内します。本書はまた、PSoC 1 を迅速に深く
理解できるように更なるリソースへのアクセスを提供します。 

PSoC 1 に加えて、サイプレスの PSoC ポートフォリオは PSoC 3、PSoC 4 および PSoC 5LP デバイスを含んでいます。
PSoC デバイスによってシステム アーキテクチャおよびペリフェラルが異なります。詳細については、「Cypress Platform 

PSoC Solutions Roadmap」を参照してください。 

2 概要 

サイプレスは、ユーザーが設計に適切な PSoCデバイスを選択し、デバイスを設計に迅速で効果的に統合するのに役立つ豊
富な情報を www.cypress.com に掲載しています。リソースの総合リストについては、知識ベース記事「How to Design with 

PSoC
®
 1, PowerPSoC

®
, and PLC – KBA88292」を参照してください。以下は PSoC 1のリソースの要約です。 

 概要: PSoCポートフォリオ、PSoCロードマップ 

 製品セレクタ: PSoC 1、PSoC 3、PSoC 4、PSoC 5LP 

 さらに、PSoC Designerにはデバイス選択ツールが含まれています。 

 アプリケーション ノート: サイプレスは、基本レベルから上級レベルまでの様々なトピックに触れる大量のPSoCアプリケーション 

ノートを提供します。以下は PSoC 1入門用の推奨アプリケーション ノートです。 

 AN75320 - Getting Started with PSoC
®
 1 

 AN2094 - PSoC
®
 1 - Getting Started with GPIO 

 AN74170 - PSoC
®
 1 Analog Structure and Configuration with PSoC Designer™  

 AN2041 - Understanding PSoC
®
 1 Switched Capacitor Analog Blocks 

 AN2219 - PSoC
®
 1 Selecting Analog Ground and Reference 

注: CY8C29X66デバイスに関するアプリケーション ノートについては、ここをクリックしてください。 

 開発キット: 

 CY3210-PSoCEval1 は、CY8C25/26xxx デバイスを除いて、車載用デバイスを含むすべての PSoC 1 アナログ／
デジタル混在信号アレイ ファミリに対応しています。このキットには、LCD モジュールやポテンショメーター、LED、
ブレッドボードが含まれています。 

 CY3214-PSoCEvalUSB は、CY8C24x94 PSoC デバイスの開発用基板を備えています。この基板の特殊な特長
には、USBおよび CapSense開発とデバッグ サポートが含まれています。 

注: CY8C29X66デバイスに関する開発キットについては、ここをクリックしてください。 

MiniProg1およびMiniProg3デバイスは、フラッシュのプログラミングとデバッグ用のインターフェースを提供します。 

http://www.cypress.com/
http://www.cypress.com/?rID=86788&source=an79953
http://www.cypress.com/?rID=86788&source=an79953
http://www.cypress.com/
http://www.cypress.com/?id=4&rID=82816
http://www.cypress.com/?id=4&rID=82816
http://www.cypress.com/?id=1573
http://www.cypress.com/?id=5041&source=PSoC3_Datasheet
http://www.cypress.com/?id=4976&source=PSoC3_Datasheet
http://www.cypress.com/?id=5044&source=PSoC3_Datasheet
http://www.cypress.com/?rID=58639
http://www.cypress.com/documentation/application-notes/an2094-psoc-1-getting-started-gpio
http://www.cypress.com/documentation/application-notes/an74170-psoc-1-analog-structure-and-configuration-psoc-designer
http://www.cypress.com/documentation/application-notes/an2041-understanding-psoc-1-switched-capacitor-analog-blocks
http://www.cypress.com/documentation/application-notes/an2219-psoc-1-selecting-analog-ground-and-reference
http://www.cypress.com/?id=1368&rtID=76
http://www.cypress.com/?rID=2541
http://www.cypress.com/?rID=37815
http://www.cypress.com/?rID=63754
http://www.cypress.com/?rID=37459
http://www.cypress.com/?rID=38154
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2.1 PSoC Designer 

PSoC Designerは無料のWindowsベースの統合設計環境 (IDE) です。アプリケーション開発は、特性化済みのアナログと

デジタル ペリフェラルのライブラリを使用してドラッグ アンド ドロップの設計環境で行われます。また、APIライブラリ上の動的

生成が行えるコードを活用して、設計をカスタマイズすることも可能です。図 1 は PSoC Designer ウィンドウを示します。 

注: これは、デフォルト画面ではありません。 

1. グローバル リソース: すべてのデバイス ハードウェアの設定  

2. パラメーター: 選択しているユーザー モジュールのパラメーター 

3. ピン配置: デバイスのピンに関する情報  

4. チップ レベル エディター: 選択したチップで使用可能なリソースの図 

5. データシート: 選択しているユーザー モジュールのデータシート 

6. ユーザー モジュール: 選択したデバイスのすべての使用可能なユーザー モジュール 

7. デバイス リソース メーター: 現時点のプロジェクト コンフィギュレーション用のデバイス リソースの使用率 

8. ワークスペース: プロジェクトに関するファイルを表示するツリー レベル図 

9. 出力: プロジェクト ビルドおよびデバッグ処理からの出力 

注: PSoC Designer の詳細情報については、PSoC Designer IDE の Help > Documentation をアクセスし、

「 Designer Specific Documents 」 フ ォ ル ダ を開い て 「 IDE User Guide.pdf 」 ド キ ュ メ ン ト を ご覧 く だ さ い 。 

 

図 1．PSoC Designerのレイアウト 
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2.2 サンプル コード 

以下のウェブページには PSoC Designerベースのサンプル コードがリストアップされています。これらのサンプル コードは、

空のページの代わりに完了した設計で始まり設計時間を短縮させることができ、PSoC Designer ユーザー モジュールが

様々な用途にどのように利用できるかを示します。 

http://www.cypress.com/documentation/code-examples/psoc-1-code-examples 

PSoC Designerに統合されているサンプル コードへアクセスするには、図 2に示すように Start Page > Design Catalog > 

Launch Example Browserを順に選択してください。 

図 2. PSoC Designer内のサンプル コード 

 

 

図 3に示す Example Projects Browserには以下のオプションがあります。 

 プロジェクトをフィルタリングするためのキーワード検索 

 カテゴリ ベースのプロジェクト リスト 

 選択したプロジェクトのデータシートをレビューします (Descriptionタブで) 

 選択したプロジェクトのサンプル コードをレビューします。このウィンドウからコードをプロジェクトにコピー アンド ペーストして

コード開発時間を短縮させることができます。 

 さらに、選択に応じて新規プロジェクト (また、必要な場合は新規ワークスペース) を作成することができます。完成した

基本的な設計で始まり設計時間を短縮させます。その設計をアプリケーションに適用することができます。 

   

http://www.cypress.com/
http://www.cypress.com/documentation/code-examples/psoc-1-code-examples
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図 3. サンプル プロジェクトおよびサンプル コード 

 

2.3 PSoC Designer Help 

PSoC Designerホームページへアクセスして PSoC Designerの最新版をダウンロードしてください。PSoC Designerを起動
して次の項目に移動します。 

 IDEユーザー ガイド: Help > Documentation > Designer Specific Documents > IDE User Guide.pdf を選択
します。このガイドは PSoC Creatorプロジェクトを開発するための基礎知識を提供します。 

 シンプルなユーザー モジュールのサンプル コード: Start Page > Design Catalog > Launch Example Browser

を選択します。これらのサンプル コードは PSoC Designer ユーザー モジュールのコンフィギュレーションおよび使用方

法をデモします。 

 テクニカル リファレンス マニュアル: Help > Documentation > Technical Reference Manualsを選択します。このガイド

は PSoC 1デバイスのシステム機能を一覧にして説明します。 

 ユーザー モジュール データシート: ユーザー モジュールを右クリックして「Datasheet」を選択します。このデータシート

は選択されたユーザー モジュールのパラメーターおよび APIを説明します。 

 デバイス データシート: Help > Documentation > Device Datasheetsを選択して特定の PSoC 1デバイスのデータ

シートへアクセスします。 

 Imagecraftコンパイラ ガイド: Help > Documentation > Compiler and Programming Documents > C Language 

Compiler User Guide.pdfを選択します。このガイドは Imagecraftコンパイラ固有の命令と関数について説明します。 

2.4 テクニカル サポート 

ご質問は、弊社のテクニカル サポート チーム対応いたします。サイプレスのテクニカル サポート ページにアクセスし、

お問い合わせ内容をケースとして作成し送信してください。 

米国のお客様は、弊社フリーダイヤル (+1-800-541-4736 ext.8) までお電話いただければ、弊社のテクニカル サポート チームが

ご対応いたします。 

http://www.cypress.com/
http://www.cypress.com/?rID=41083&source=CY-ENG-HEADER&medium=GNAV
https://secure.cypress.com/myaccount/?id=25&techSupport=1&source=an79953
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早急な対応が求められる場合には、下記の方法をご利用ください。 

 セルフ ヘルプ 

 所在地の販売代理店 

3 PSoC 1 ファミリの比較 

PSoC 1には 13デバイス ファミリがあります。表 1は、これらのデバイス ファミリで対応されている機能を示します。 

 

表 1. PSoC 1デバイス セレクタの概要表

機能 

デバイス ファミリ 

29x66 28xxx 27x43 24x94 24x93 24x33 24x23A 23x33 22x45 21x45 21x34 21x23 

フラッシュ 

(KB) 
32K 16K 16K 16K 32K 8K 4K 8K 16K 8K 8K 4K 

SRAM (KB) 2K 1K 256B 512B 2K 256B 256B 256B 1K 512B 512B 256B 

ADC 1 

(DS/SS) 

14 

ビット 

(DS) 

4x14 

ビット 

(DS) 

11 

ビット 

(DS) 

14 

ビット 

(DS) 

10 

ビット 

(INC) 

11 

ビット 

(DS) 

11 

ビット 

(DS) 

11 

ビット 

(DS) 

8 

ビット 

(SS) 

8 

ビット 

(SS) 

10 

ビット 

(SS) 

10 

ビット 

(SS) 

ADC 2 

(SAR) 
- 

10 

ビット 

(150 
Ksps) 

- - - 

8 

ビット 

(300 
Ksps) 

- 

8 

ビット 

(300 
Ksps) 

10 

ビット 

(150 
Ksps) 

10 

ビット 

(150 
Ksps) 

- - 

コンパレータ 4 4 4 2 2 2 2 2 4 4 2 2 

DAC  

(8ビット) 
4 4 4 2 - 2 2 2 - - - - 

PGA  

(x48ゲイン) 
4 4 4 2 - 2 2 2 - - - - 

TCPWM 

(16ビット) 
8 6 4 2 

3  

(タイマー) 
2 2 2 4 2 2 2 

UART/SPI 4 3 2 1 1 SPI 1 1 1 2 1 1 1 

I2C 1 2 1 1 
1  

(スレーブ) 
1 1 1 1 1 1 1 

CapSense

ボタン 
- 43 - 49 - - - - 37 23 23 - 

GPIO 64 44 44 50 36 26 24 26 38 24 24 16 

USB - - - FS 2.0 FS 2.0 - - - - - - - 

ECO Y Y Y N Y Y Y Y Y Y N N 

SMP Y Y Y N N N Y N Y Y Y Y 

MAC 2 2 1 2 0 1 1 1 1 1 0 0 

FS = フル スピード、SMP = スイッチ モード ポンプ、ECO = 外部水晶振動子、MAC = 積和演算器、INC = インクリメンタル、DS = デュアル スロープ、SS = シングル スロープ、PGA = プログラマブル ゲ

イン アンプ、TCPWM = タイマー カウンター パルス幅変調器、UART = ユニバーサル非同期レシーバー トランスミッター、SPI = シリアル ペリフェラル インターフェース、I2C = インター インテグレーテッド 

サーキット 

http://www.cypress.com/
http://www.cypress.com/?id=4
http://www.cypress.com/?id=1062
http://www.google.co.in/url?sa=t&rct=j&q=&esrc=s&source=web&cd=7&ved=0CEUQFjAG&url=http%3A%2F%2Fwww.embedded.com%2Felectronics-blogs%2Fbeginner-s-corner%2F4023908%2FIntroduction-to-Serial-Peripheral-Interface&ei=rkM-U43SK4X3rQfFhoAY&usg=AFQjCNEtX3Xm4fd8n8eB_cskEKf0dsqKdw&bvm=bv.64125504,d.bmk
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4 PSoC 1の機能セット 

PSoC 1は図 4に示すように、CPU コア、デジタル サブシステム、アナログ サブシステム、メモリ サブシステム、システム 

リソースを含む幅広い能力と機能を備えています。次の節は各機能について簡単に説明します。詳細については、PSoC 1

ファミリのデバイス データシート、テクニカル リファレンス マニュアル (TRM) および「PSoC 1学習資料」にリストアップされた

アプリケーション ノートを参照してください。 

図 4. PSoC 1アーキテクチャ (CY8C29466) 
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図 4 は CY8C29466 デバイスで対応されている機能を示します。これらの機能のサブセットは他のデバイスで使用可能です。

表 1を参照してください。  

http://www.cypress.com/
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4.1 M8Cプロセッサおよびメモリ 

PSoC 1 は、ハーバード アーキテクチャの 8 ビット RISC CPU である M8C プロセッサを内蔵しています。これは 24MHz

の最大周波数で動作可能で、4MIPS の性能を実現します。M8C には 37 の命令があります。表 1 に示すように、PSoC 1

デバイスは最大 2KBの SRAMと 32KBのフラッシュ メモリを内蔵します。詳細については、PSoC 1 テクニカル リファレンス 

マニュアルを参照してください。 

4.2 プログラマブル デジタル サブシステム 

PSoC のデジタル サブシステムは、そのプログラマビリティと配線システムによりユニークなものとなっています。表 1 は、

各種の PSoC 1製品および各デバイスで使用可能なデジタル リソースを一覧にします。PSoC 1内のデジタル ブロックは

デジタル基本ブロック (DBB) とデジタル通信ブロック (DCB) に分かれています。DBB数と DCB数は常に等しいです。  

4.2.1 デジタル基本ブロック  (DBB) 

DBB は、タイマーやカウンター、PWM などとして機能させるようにプログラムできる基本的なコンフィギュレーション可能な

デジタル リソースです。各DBBには 8ビット リソースを割り当てられます。16ビット、24ビット、または 32ビット デジタル リソース

を構築するにはそれぞれ 2個、3個、または 4個の DBBが必要です。  

4.2.2 デジタル通信ブロック  (DCB)  

DCBには、基本的なデジタル リソース (タイマーやカウンター、PWMなど) を割り当てるだけでなく、SPIや UARTなどの

通信リソースを割り当てることもできます。DBB コンポーネントを DCB に配置することは可能ですが、DCB リソースを DBB に

配置することはできません。  

4.3 プログラマブル アナログ サブシステム 

PSoC 1独自のアナログ サブシステムは、列に配置されたアナログ ブロックで構成されています。これらのアナログ ブロックは

連続時間 (CT) ブロックとスイッチト キャパシタ (SC) ブロックに分かれています。 

4.3.1 連続時間  (CT) ブロック  

PSoC内の CTブロックは、コンパレーターまたはプログラマブル ゲイン アンプ (PGA) としてコンフィギュレーションできる

プログラマブル アナログ ブロックです。CTブロックは低ノイズ オペアンプと低オフセット オペアンプを中心に構築されています。

CT ブロックには多くのアナログ マルチプレクサがあり、高いコンフィギュアビリティを実現します。CT ブロックの構造と構成の

詳細については、PSoC 1 テクニカル リファレンス マニュアルの第 22章を参照してください。 

4.3.2 スイッチト  キャパシタ  (SC) ブロック  

CTブロックと同様に、SCブロックはアナログ マルチプレクサに囲まれた低ノイズ オペアンプと低オフセット オペアンプを中心に

構築されています。これらのブロックは、オペアンプとマルチプレクサの周囲のキャパシタとスイッチのグループによりユニークな

ものとなっています。CT ブロックとは異なり、SC ブロックに抵抗アレイはありません。SC ブロックのアーキテクチャの詳細に

ついては、PSoC 1 テクニカル リファレンス マニュアルの第 23 章または「AN2041 – Understanding PSoC 1 Switch 

Capacitor Analog Blocks」を参照してください。 

4.4 システム全般リソース 

4.4.1 クロッキング  システム  

PSoCは、複数のクロック ソースを持った高度なクロック システムを搭載しており、その中の多くはプログラム可能です。主要

のクロック ソースは、内蔵の 24MHz内部主振動子 (IMO) または 24MHz以下の外部クロック ソースから派生できます。

さらに、32kHz 振動子回路または内部低速振動子 (ILO) を低速振動子に使用することができます。PSoC 1 で使用可能な

クロックの詳細については、「AN32200 - PSoC® 1 - Clocks and Global Resources」を参照してください。  

4.4.2 スイッチ  モード  ポンプ  (SMP) 

スイッチ モード ポンプ (SMP) は PSoCでサポートされている DC/DCブースト回路であり、デバイスが単一の 1.5Vバッテリで

動作できるようにします。PSoC には、ブースト回路の実行用に内蔵 FET および独立した PWM ハードウェアがあります。

ブースト回路の構成要素は外部バッテリ、インダクタ、ダイオード、コンデンサ各 1個のみです。詳細については、PSoC 1

テクニカル リファレンス マニュアルの第 30章を参照してください。 

http://www.cypress.com/
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A1278&f%5b2%5d=resource_meta_type%3A583
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A1278&f%5b2%5d=resource_meta_type%3A583
http://www.cypress.com/documentation/technical-reference-manuals/cy8cplc20-cy8cled16p01-cy8c29x66-cy8c27x43-cy8c24x94?source=search&cat=technical_documents
http://www.cypress.com/documentation/technical-reference-manuals/cy8cplc20-cy8cled16p01-cy8c29x66-cy8c27x43-cy8c24x94?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an2041-understanding-psoc-1-switched-capacitor-analog-blocks
http://www.cypress.com/documentation/application-notes/an2041-understanding-psoc-1-switched-capacitor-analog-blocks
http://www.cypress.com/?rID=2773
http://www.cypress.com/documentation/technical-reference-manuals/cy8cplc20-cy8cled16p01-cy8c29x66-cy8c27x43-cy8c24x94?source=search&cat=technical_documents
http://www.cypress.com/documentation/technical-reference-manuals/cy8cplc20-cy8cled16p01-cy8c29x66-cy8c27x43-cy8c24x94?source=search&cat=technical_documents
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4.4.3 積和演算器  (MAC)  

積和演算器 (MAC) は符号付数字の 8ビット乗算器および総和用 32ビット加算器を提供しています。MACは演算の実行や

デジタル フィルターの実装に非常に便利です。デバイスの特定のレジスタに読み書きすることで MAC を使用できます。

乗算の後、値をレジスタから読み出すかアキュムレータに保存できます。クリア レジスタ (MACx_CL1とMACx_CL2) に書き込む

ことでアキュムレータをクリアし、0 の値にリセットすることができます。詳細については、PSoC 1 テクニカル リファレンス 

マニュアルの第 26 章を参照してください。 

4.4.4 電圧リファレンス  

PSoC 1には電圧リファレンス向けに多くのオプションが用意されています。次は 3つの主な用語です。 

1. AGND 

2. RefHi 

3. RefLo 

デバイスのアナログ信号はアナログ グランド (AGND) にバイアスされています。AGND の電圧位置は開発者によって幅広い

オプションから選択されます。AGND より高いアナログ信号は正電圧、それ未満は負電圧とされます。RefHi と RefLo は

アナログ  システムの上限と下限を意味します。詳細については、AN2219 - PSoC® 1 Selecting Analog Ground and 

Referenceを参照してください。  

4.4.5 専用 I
2
C ハードウェア  

I
2
C 通信ブロックは、PSoC デバイスを 2 線式 I

2
C シリアル通信バスとインターフェースするよう設計されたシリアル-パラレル 

プロセッサです。M8C マイクロコントローラーの過剰な介入とオーバーヘッドをなくすために、このブロックは I
2
C 固有の

ステータス検出とフレーミング ビット生成のサポートを提供します。  

以下は PSoC I
2
Cハードウェア コントローラーの主な特長と機能です。 

 業界標準の Philips
®
 I

2
Cバス互換インターフェース 

 マスターおよびスレーブ動作、マルチマスター可能 

 2本のピン (SDAと SCL) のみで I
2
Cバスとのインターフェースを実現 

 100/400kbpsの標準データ転送速度；50kbpsにも対応 

 7ビット アドレッシング モード；10ビット アドレッシングにも対応 

I
2
Cの使用の詳細情報は、「AN50987: Getting Started with I2C in PSoC 1」を参照してください。 

4.5 GPIOシステム 

GPIOシステムは CPUやペリフェラルと外部間のインターフェースを提供します。各 GPIOは、デジタル I/Oとして使用される

と、ピン当たり 10mA の吐き出し電流、25mA の吸い込み電流が可能です。デバイスは片側 100mA、合計 200mA を吸い

込めます。したがって、任意のポートの偶数番号ピンは合計 100mA、奇数番号ピンはもう 100mA の電流に対応できます。

デバイスは片側 40mA、合計 80mAを吐き出せます。詳細については、PSoC 1 テクニカル リファレンス マニュアルの第 6章

および「AN2094 - PSoC
®
 1 - Getting Started with GPIO」を参照してください。 

4.6 CapSense 

PSoC 1 デバイスには、CapSense として知られた静電容量タッチ センシングに対応しているデバイスがあります。静電容量

タッチ センサーは、人体の静電容量を使ってセンサー上またはセンサー近く (近接) の指の存在を検出するユーザー インタ

ーフェースのデバイスです。静電容量センサーは審美的に優れており、使い易く、長寿命を持っています。CapSense により、

高価で信頼性の低いメカニカル ボタンを、単にプリント基板上の銅配線である静電容量ボタンに置き換えることができます。

CapSense はボタンやスライダー、トラックパッド、近接センサーなど幅広いセンサーに対応しています。CapSense に対応

している PSoC 1の一覧は、表 1を参照してください。詳細については、「AN64846 - Getting Started with CapSense」を参照

してください。  

http://www.cypress.com/
http://www.cypress.com/documentation/technical-reference-manuals/cy8cplc20-cy8cled16p01-cy8c29x66-cy8c27x43-cy8c24x94?source=search&cat=technical_documents
http://www.cypress.com/documentation/technical-reference-manuals/cy8cplc20-cy8cled16p01-cy8c29x66-cy8c27x43-cy8c24x94?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an2219-psoc-1-selecting-analog-ground-and-reference
http://www.cypress.com/documentation/application-notes/an2219-psoc-1-selecting-analog-ground-and-reference
http://www.cypress.com/?rID=34486
http://www.cypress.com/documentation/technical-reference-manuals/cy8cplc20-cy8cled16p01-cy8c29x66-cy8c27x43-cy8c24x94?source=search&cat=technical_documents
http://www.cypress.com/?docID=46288
http://www.cypress.com/?docID=46288
http://www.cypress.com/?docID=46288
http://www.cypress.com/documentation/application-notes/an2094-psoc-1-getting-started-gpio
http://www.cypress.com/documentation/application-notes/an64846-getting-started-capsense?source=search&keywords=getting%20started%20with%20capsense
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4.7 ダイナミックなリコンフィギュアビリティ 

PSoC 1 では、最終製品の詳細が分かっていなくてもプロジェクトの設計を開始して、必要に応じてリソースを追加することが

できます。デジタルまたはアナログ リソースが利用可能である限り、調整、適用、拡張が可能です。リソースが消費されて 

しまった設計でも、別の機能の実行するために実行中に PSoC をダイナミックにリコンフィギュレーションすることができます。

これにより、PSoC のシステム リソースを再利用し、集積能力を最大限に発揮させることができます。詳細については、

「AN2104 - PSoC®1 - Dynamic Reconfiguration With PSoC® Designer™」を参照してください。 

5 開発ツール 

サイプレスの PSoC 1は、PSoC Designerソフトウェア ツール、開発キットやプログラミング ハードウェア、デバッグ ハードウェア

を含むハードウェア ツールなどの品質の高い開発ツールでサポートされています。これらのツールにより、デバイスのコンフィ

ギュレーション、アプリケーション コードの開発、また組み込み設計のビルド、デバッグ、そして展開が可能です。 

5.1 ソフトウェア: PSoC Designer IDE 

サイプレスの PSoC Designerは、PSoC 1デバイスのカスタマイズ、コンフィギュレーション、プログラミングに使用される統合

開発環境 (IDE) です。このツールは http://www.cypress.com/go/psocdesignerからダウンロードできます。  

PSoC Designer は、アナログとデジタル ペリフェラルをコンフィギュレーションして PSoC アプリケーションを作成し、アプリ

ケーションコードを書き、本アプリケーション ノートで説明するその他の機能を実行することが可能な完全な開発環境を提供

します。さらにこのソフトウェアにより、PSoC ICE-Cubeデバッグ プラットフォームを使用して PSoCデバイスをプログラムし、

プロジェクトをデバッグすることが可能です。 

図 5 は、PSoC Designer のレイアウトおよび IDE の各部分の説明を示します。なお、これは PSoC Designer のデフォルト 

レイアウトではありません。Designer を起動する時に以下に示すウィンドウが表示されない場合は、ツールバーの View

ドロップダウン メニューから追加できます。 

図 5. PSoC Designerのレイアウト 

 
 

http://www.cypress.com/
http://www.cypress.com/?rID=2901
http://www.cypress.com/go/psocdesigner


================ 

 

PSoC
®
 1入門 

 

_________________________________________________________________________________________________________________ 
 

 www.cypress.com 文書番号: 001-79363 Rev. *D 11 

5.2 ハードウェア 

サイプレスは設計の要件を満たすために PSoC 1向けのハードウェア キットを提供しています。PSoC 1デバイスを選択する
には、「PSoC 1 Kits」および「PSoC 1 Kit Selector Guide」を参照してください。以下の節は開発キット、プログラミング ハード
ウェアおよびデバッグ ハードウェアの一覧について紹介します。  

5.2.1 開発キット  

サイプレスは PSoC 1 設計を容易に試作する手助のためにいくつの開発キットを提供しています。表 2 は PSoC 1 の評価を

サポートするいくつかの開発キットを一覧にします。開発キット／基板の完全なリストについては、開発キットを参照してください。 

表 2. PSoC 1開発キット 

開発キット 説明 

CY3210-
PSOCEVAL1  

CY3210 PSoC Eval1キットにより、サイプレスの PSoC 1プログラマブル システムオンチップの

設計手法とアーキテクチャの評価および実験が可能です。 

CY8CKIT-001 
CY8CKIT-001 PSoC開発キットは、異なるソリューションの試作と評価を可能にする一般的な

開発プラットフォームを提供します。 

5.2.2 プログラミング  ハードウェア  

サイプレス提供およびサードパーティのツールのいくつかのオプションから選択できます。サイプレスは 4 種のプログラミング 

デバイスを提供しています: MiniProg1、MiniProg3、ICE-Cube、CY3207-ISSP。 

MiniProg1 

MiniProg1は多くの PSoC 1キットに同梱されている ISSPプログラマです。このプログラマは CY25/26xxxを除き、すべての

PSoC 1デバイスに使用できます。MiniProg1は PSoC 3および PSoC 5デバイスのプログラミングには使用できません。 

MiniProg3 

MiniProg3は CY8CKIT-001開発キットに同梱されている ISSPプログラマです。MiniProg3には、PSoC 1、PSoC 3および
PSoC 5デバイス用のプログラマ、PSoC 3および PSoC 5アーキテクチャ用のデバッグ ツール、I2Cシリアル接続のデバッグ
および PSoCデバイスとの通信用の USB-I2Cブリッジが一体化されています。 

サードパーティのプログラマ 

サードパーティのプログラマ ツールの一覧は、http://www.cypress.com/documentation/development-kitsboards/general-psoc-

programmingを参照してください。これらのツールは PSoC 1デバイスのプログラミングをサポートするように設計およびテストされ、
サイプレスによって認定されました。  

5.2.3 デバッグ  ハードウェア  

CY3215A-DK  

CY3215A-DK In-Circuit Emulation Lite Development Kitにはインサーキット エミュレータ (ICE) が含まれています。ICE-

Cube は主に PSoC 1 デバイスのデバッグに使用しますが、ISSP を使用して PSoC 1 デバイスのプログラムもできます。

青色の CAT5ケーブルやフレックス ケーブルを使ってデバッグ ポッドとインターフェースする代わりに、黄色の ISSPケーブル

を使ってデバイスをプログラムすることができます。このため、ICE-Cube はデバッグとプロダクション環境に非常に便利です。

詳細は、「AN73212 – Debugging with PSoC 1」を参照してください。 

6 PSoC 1学習資料 

本節は、PSoC 1の入門および完全なアプリケーションの開発に役立つ PSoC 1学習資料の一覧を提供します。データシート、

リファレンス マニュアル、ビデオ、アプリケーション ノートなど PSoC 1開発者が利用できる多くのリソースが用意されています。 

6.1 PSoC 1データシート 

全ての PSoC 1 デバイス ファミリの機能および電気的仕様をリストアップする PSoC 1 データシートについては、PSoC 1

データシートのページにアクセスしてください。 

http://www.cypress.com/
http://www.cypress.com/?rID=63754
http://www.cypress.com/?docID=36495
http://www.cypress.com/?id=1573&rtID=110
http://www.cypress.com/?rID=2541
http://www.cypress.com/?rID=2541
http://www.cypress.com/?rID=37464
http://www.cypress.com/?rID=37459
http://www.cypress.com/?rID=38154
http://www.cypress.com/?rID=37464
http://www.cypress.com/documentation/development-kitsboards/general-psoc-programming
http://www.cypress.com/documentation/development-kitsboards/general-psoc-programming
http://www.cypress.com/?rID=64120
http://www.cypress.com/?rID=57555
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=107&id=1573&applicationID=0&l=0
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=107&id=1573&applicationID=0&l=0
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6.2 PSoC 1 Designerの学習 

PSoC Designerホームページへアクセスして PSoC Designerの最新版をダウンロードしてください。 

PSoC Designerを起動して次の項目に移動します。 

PSoC Designer ユーザー  ガイド : PSoC Designer ユーザー  ガイドのページへアクセスして ください 。 

 

6.2.1 IDE ユーザー  ガイド :  

PSoC Designerを起動して、Help > Documentation > Designer Specific Documents > IDE User Guideを選択します。

このガイドは PSoC Designerプロジェクトを開発するための基礎知識を提供します。 

6.2.2 サンプル  プロジェクト  

PSoC Designer を起動して、Design Catalog > Example projects を選択します。これらのサンプル プロジェクトは、

PSoC Designerのコンポーネントのコンフィギュレーションと使用方法をデモします。 

6.2.3 PSoC Des igner のトレーニング  

これらのトレーニングは設計の手助けとなり、「Intro to PSoC Designer」、「Dynamic Reconfiguration」および「Debugging 

with PSoC」の内容を演習します。 

6.2.4 コンポーネント  データシート :  

PSoC Designerを起動して、Workspace Explorerを開きます。Chipタブで、コンポーネントを右クリックして Datasheetを

選択します。 

6.3 アプリケーション ノート 

アプリケーション ノートは、デバイスの特定の機能を理解し、PSoC 1 アプリケーションを設計する手助けをします。PSoC 1

のアプリケーション ノートの完全なリストについては、PSoC 1 アプリケーション ノートのページへアクセスしてください。 

6.4 知識ベース記事 

技術サポート関連のよく聞かれる質問と答えを蓄積したデータベースがあります。PSoC 1 の知識ベース記事の完全なリスト

については、知識ベース記事のページへアクセスしてください。 

6.5 テクニカル リファレンス マニュアル (TRM) 

TRM は PSoC 1 デバイスの内部アーキテクチャの詳細な説明を提供します。PSoC 1 の TRM の完全なリストについては、

PSoC 1 テクニカル リファレンス マニュアルのページへアクセスしてください。 

6.6 デバイス エラッタ 

これらの資料は、デバイス データシートまたはテクニカル リファレンス マニュアルから外れる仕様 (ある場合) を記載しています。

デバイスのエラッタ資料の一覧については、デバイス エラッタのページへアクセスしてください。 

6.7 テクニカル サポート 

お問い合わせまたはご質問は、弊社のテクニカル サポート チームが対応いたします。サイプレスのテクニカル サポートに

アクセスし、お問い合わせ内容をケースとして作成し送信してください。 

米国のお客様は、弊社フリーダイヤル (+1-800-541-4736 ext.8) までお電話いただければ、弊社のテクニカル サポート チームが

ご対応いたします。 

早急な対応が求められる場合には、下記の方法をご利用ください。 

 セルフ ヘルプ 

 所在地の販売代理店 
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7 はじめての PSoC 1設計 

本節は、PSoC Designerを用いて PSoC 1を使ったシンプルなデザインを設計して、それを PSoCデバイスにプログラムし、

また PSoC 1デモ基板をコンフィギュレーションしてアプリケーションの結果を検証する、段階を追ったプロセスを説明します。 

7.1 設計について 

本設計では、2つの GPIOで 2つの PWM出力 (1つはハードウェア リソースを使用し、もう 1つはソフトウェアを使用) を

生成するシンプルなプロジェクトを作成します。1つの GPIOは固定速度で点滅する LEDを示し、もう 1つの GPIOはパルス 

(ハートビート) LEDを示します。本設計ではまた、ADCユーザー モジュールを使用してアナログ電圧を測定します。  

7.2 はじめての PSoC 1設計の作成 

7.2.1 プロジェクトの作成  

まず、PSoC Designer でプロジェクトを作成します。ここで、デバイスを選択して、開発言語を C に設定します。この例では、

CY3210-PSoCEval1キットに同梱されている CY8C29466-24PXIを使用します。  

1. 図 6に示すように、PSoC Designerで File > New Projectを選択して AN75320と名付けます。 

図 6. PSoC Designerで新規プロジェクトを作成 

 

2. 図 7に示すように、Device Catalogをクリックしてデバイスを選択します。 

図 7. 「Device Catalog」 
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注: このプロジェクトを他のキットで開発する際は、以下の製品番号を使用してください。 

 CY3214-PSoCEvalUSB: CY8C24994-24LTXI 

 CY3271-PSoC First Touch: CY8C20634-12FDXI 

3. 「Create Project with CY8C29466-24PXI」をクリックして、OKをクリックします。 

プロジェクト ワークスペースが開き、Chip EditorとWorkspace Explorerを表示します。Chip Editorは、選択したデバイスの
ブロック図を示します。Ctrlを押しながらクリックして Chip Editorビューをズームインします。  

7.2.2 ユーザー  モジュールの選択  

このステップでは、User Module Catalog から必要なコンポーネントを選択してそれらをコンフィギュレーションします。ユーザ 

モジュールのウィンドウは図 8に示すように、右下にあります。View > User Module Catalogを選択してそれを表示させます。 

図 8. ユーザ モジュール カタログ ウィンドウ 

 

このプロジェクトは次のユーザ モジュールを使用します。 

 ADCユーザー モジュール 1個 

 PWM8ユーザー モジュール 2個 

 LCDユーザー モジュール 1個 

1. ユーザ モジュールを配置するするには次のステップを行ってください：User Module Catalog 内で ADCs フォルダを

展開します。 

2. EzADCを右クリックして、Placeを選択します。EzADCコンフィギュレーション ウィンドウが開きます。 

3. コンフィギュレーション ウィンドウ内でDouble Stage Modulatorを選択して、OKをクリックします。(このコンフィギュレーション

では、高い性能のために 2個のスイッチト キャパシタを使用します。)  

4. PWMsフォルダの下で PWM8を右クリックして、Placeを選択します。  

5. 配置プロセスを繰り返して 2個の PWM8ユーザー モジュールを設計に配置します。  

6. Misc Digitalフォルダから LCDをクリックして、Placeを選択します。  

必要なユーザー モジュールの配置を完了した後、Designer ウィンドウは図 9 のようになります。また、配置したユーザー 

モジュールは Workspace Explorerに表示されます。配置した各ユーザー モジュールは ComponentName_1などのように
名付けられます。例えば、EzADCユーザー モジュールは EzADC_1としてリストアップされます。 
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図 9. Chip Editor内の EzADCと PWMユーザー モジュールの配置 (デジタル ブロック) 

 

図 10. Chip Editor内の EzADCユーザー モジュールの配置 (アナログ ブロック) 

 

7.2.3 ユーザー  モジュール  パラメーターの設定   

このステップでは、設計に配置したユーザー モジュールのパラメーターを設定します。  

Workspace Explorer または Chip Editor からユーザー モジュールをクリックすると、選択したユーザー モジュールの
Parametersウィンドウが左側に表示されます。このウィンドウでは、パラメーターを変更することができます。  

設定または変更するパラメーターについては、以下の図を参照してください。  

1. EzADC_1を選択して、そのパラメーターを表 3に基づいて変更します。変更した後、ウィンドウは図 11のようになります。

初期設定値から変更されるパラメーターは強調表示されています。  

表 3. EzADC_1ユーザー モジュールのパラメーター 

パラメーター 値 説明 

Name (名称)  EzADC_1 ユーザー モジュールに名称を付ける 

DataFormat (データ形式) Unsigned (符号なし) 入力は正の値のみであるため、出力を符号

なしデータに設定 

Resolution (分解能) 14 Bit 

(14ビット) 

EzADCの最大分解能を設定 

Sample Rate  

(サンプル レート) 

0.007 サンプル レートは分解能に依存。EzADC

のユーザー モジュール データシートを参照

してください。 

Input (入力) AnalogColumn_Inpu

tMUX_0 

ソースの入力アナログ電圧を受信するよう
アナログ入力データ バスを選択 

Offset Compensation 

(オフセット補正) 

Enable (有効) 相関 2重サンプリングを有効にする 
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パラメーター 値 説明 

Buffer Gain (バッファ ゲイン) 1.000 増幅しないように PGAゲインを 1に設定  

Reference (リファレンス)  VSS オフセット補正を行うために PGAのリファレ

ンス電圧を設定 

AGND Output (AGND出力) Disable (無効)  AGND出力を無効にする。このオプション
は、内部 AGNDを外部ピンに出して両極性

信号を ADCに接続するために使用可能 

Offset Compensation Freq 

(オフセット補正周波数) 

2 オフセットの補正間の ADC サンプル数を

設定 

図 11. EzADC_1ユーザー モジュールのパラメーター 

 

PWM8_1 を変更して、そのパラメーターを表 4のように変更します。変更した後、ウィンドウは図 12のようになります。これで、

ユーザー モジュールの名称が LED1_PWMに変更されたことに注意してください。 

表 4. LED1_PWMユーザー モジュールのパラメーター 

パラメーター 値 説明 

Name (名称) LED1_PWM ユーザー モジュールに名称を付ける 

Clock (クロック) VC3 クロック ソースに VC3を選択  

Enable (イネーブル) High (高) 連続カウントのために「High」を選択 

CompareOut (比較出力) Row_0_Output_2 行出力バスを介して比較出力を GPIOに接続 

Terminal Count Out 

(ターミナル カウント出力)  
None (無) これは補助カウンターであり、どの行出力バスにも接続する必要はない  

Period (周期) 254 カウンターの周期を設定 

Pulse Width (パルス幅) 127 PWM出力のパルス幅 (50%デューティ サイクル) を設定 

Compare Type (比較条件) Less Than Or Equal (未満または

等しい) 

比較機能の比較条件を選択 

Interrupt Type (割り込みタイプ) Terminal Count  

(ターミナル カウント) 
これを選択すると、カウンター レジスタのターミナル カウント時に割り 

込みが発生される 

Clock Sync  

(クロック同期) 
Sync to SysClK (SysClKと同期) クロック入力をシステム クロックと同期化 

Invert Enable 

(イネーブル入力の反転) 
Normal (通常) イネーブル入力信号の極性を決定 
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図 12. PWM_1ユーザー モジュールのパラメーター 

 

2. PWM8_2 を選択して、そのパラメーターを図 13 のように変更します。これで、ユーザー  モジュールの名称が

LED2_PWMに変更されたことに注意してください。  

図 13. PWM_2ユーザー モジュールのパラメーター 

 

3. LCD_1ユーザー モジュールを変更して、そのパラメーターを表 5 のように変更します。変更した後、ウィンドウは図 14

のようになります。 

表 5. LCD_1ユーザー モジュールのパラメーター 

パラメーター 値 説明 

Name (名称) LCD_1 ユーザー モジュールに名称を付ける 

LCD Port 

(LCDポート) 

Port_2 LCDディスプレイ モジュールを割り当て

られたポートへインターフェースさせる 

BarGraph  

(バー グラフ) 

Disable 

(無効) 
バー グラフ機能を無効にする 

図 14. LCDパラメーター 
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4. View > Global Resources を選択してグローバル リソース ウィンドウを開きます。ここで、ソース クロック VC3 を

PWM クロック周波数に、Ref Mux を ADC 入力データ範囲に設定します。他のパラメーターは初期値のままにします。

変更した後、グローバル リソース ウィンドウは図 15 のようになります。グローバル リソースの詳細情報については、

IDEユーザー ガイドを参照してください。 

図 15. グローバル リソースのパラメーター 

 

7.3 PWM信号のルーティング  

本節では、PWM信号を PWMユーザー モジュールから選択された GPIOへ配線します。 GPIOピン上の信号を見るには、

PWM信号の配線を実装しなければなりません。 

本設計はまた、2 つの PWM 出力を XOR ゲートに供給して論理レベルを行出力に実装します。XOR がとられる 2 つの

PWM信号の周期差は、パルス (ハートビート) エフェクトを作り出します。  

1. LED1_PWMの CompareOutを Row_0_Output_2に接続します。 

2. LED2_PWMの CompareOutを Row_0_Output_3に接続します。  

3. 自動ルーティングを使用して LED1_PWM の CompareOut を Port_1_2 に接続します。Shift を押しながら

LED1_PWM の CompareOut ピンを選択して、図 16 に示すようにそれを Port_1_2 と接続します。また、

GlobleOutOdd_2を使用して LED1_PWMを Port_1_2に手動で接続できます。  

図 16. 行出力に接続された PWM 
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4. Row_0_Output_2デジタル相互接続をクリックして、図 17に示すようにコンフィギュレーション オプションを開きます。 

図 17. RO0[2]のデジタル相互接続ビュー 

 

5. LogicTable_Select (中央の四角形ボックスに示される) をクリックし、図 18 に示すようにドロップダウン リストから

A_XOR_Bを選択して、Closeをクリックします。 

図 18. デジタル相互接続のコンフィギュレーション 

 

6. デジタル ルーティング図が図 19 のようになったことを確認してください。それらが一致していれば、パルス状のハート

ビート LEDのコンフィギュレーションは完了しました。 

図 19. Designerのチップ ビュー 

 

7.4 コードの追加 

このステップでは、点滅 LED を生み出すソフトウェア LED を実装するためにコードを追加して全てのユーザー モジュールと

GPIOをコンフィギュレーションします。以下のコードをプロジェクトのmain.cファイルに追加します。  

1. Workspace Explorerで、AN75320 Folderの下で Source Filesフォルダを探してmain.cファイルを開きます。 

2. 以下の Cコードをコピーして main.cファイルにある既存のコードを置き換えてペーストします。 

コード 1. プロジェクト 1のmain.c 
/* part specific constants and macros */ 

#include <m8c.h>         

 

/* PSoC API definitions for all User Modules */ 

#include "PSoCAPI.h"     

 

/* Definitions for all input and output operation */ 

#include "stdio.h" 
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/* Macros to set ADC parameters */ 

#define GAIN   1 

#define MAX_ADC_COUNTS 16383 

#define ADC_RANGE  5000 

 

/* Macros to select port 1 */ 

#define PORT_1_3        PRT1DR 

 

/* Variable to store the ADC result */ 

WORD adc_result;    

 

/* Variable to store the measured input in millivolts */ 

WORD v_in;     

void main(void) 

{ 

    static unsigned int index; 

  

/* Buffer used for the long to ASCII conversion */ 

char LCDBuffer[17];  

 

/* Initializes LCD to use the multi-line 4-bit interface  */ 

LCD_1_Start(); 

 

/* Enable global interrupts */ 

M8C_EnableGInt ;  

 

/* Set the position to print the character */ 

LCD_1_Position(0,0);  

 

/* print the Hello World in the first line */ 

LCD_1_PrCString("Hello World!"); 

 

/* Starts the LED1_PWM and LED2_PWM, high enable input begins the Counter */ 

LED1_PWM_Start();  

LED2_PWM_Start(); 

 

/* Initializes and starts the EzADC User Module resources */ 

EzADC_1_Start(EzADC_1_HIGHPOWER);  

 

/* Starts the ADC conversion */ 

EzADC_1_GetSamples(0);  

   while(1) 

 { 

    /* Wait for the ADC result to be available */ 

    while(!(EzADC_1_fIsDataAvailable()));  

     

    /* Read the ADC result and clear the data ready flag */ 

    adc_result = EzADC_1_iGetDataClearFlag();  

     

    /* Calculate input voltage in mV */ 

    v_in = (DWORD)adc_result*ADC_RANGE / MAX_ADC_COUNTS / GAIN;  

     

    /* Convert the input voltage to an ascii string */ 

    csprintf(LCDBuffer, "ADC INPUT:%4dmV", v_in); 

     

    /* Set the position to print the character */ 

    LCD_1_Position(1,0);  

     

    /* print the voltage in the second line */ 

    LCD_1_PrString(LCDBuffer); 
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    /* Toggle the pin 1[3]*/ 

    PORT_1_3 ^= 0x08;  

     

    /* Give some delay to view toggling effect*/ 

        for(index = 0; index < 22000; index++);  

   } 

} 

 
3. local.mk ファイルをプロジェクトに追加して ADC の浮動小数点を有効にします。この機能の詳細情報については、

local.mkファイルを見てください。  

 

7.5 ピン配置のコンフィギュレーション 

このステップでは、ピンが LED を駆動するよう GPIO ドライブ モードをコンフィギュレーションします。Pinout ビュー (View > 

Pinout) で、選択したデバイスのピン配置をコンフィギュレーションします。Pinout パネルはワークスペースの左下に表示

されます。 

1. Pinoutビューで、P0[1]、P0[5]、P1[2]、および P1[3]のオプションを展開します。図 20に示すようにピンをコンフィギュレーション

します。 

図 20. ピン コンフィギュレーション 

 

 

7.6 ビルドおよびプログラム 

このステップでは、MiniProg1デバイスをコンピュータに接続し、ビルドしたプロジェクトを PSoCデバイスにプログラムします。  

1. Build > Generate/Build ‘AN75320’ Projectを選択する、または F6を押します (図 21を参照してください)。  
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図 21. ビルドおよび生成オプション 

 
 

2. 図 22 に示すように、出力ウィンドウは RAM/フラッシュの使用量およびエラーと警告の件数を含むビルドの状態を示します。 

図 22. 出力ウィンドウ 

 

3. MiniProg1／MiniProg3をコンピュータに接続します。 

4.  MiniProg1／MiniProg3 を基板のプログラミング ヘッダーに接続します。詳細については、Error! Reference source 

not found.のステップ 4を参照してください。 

5. Program > Program Partを選択します (図 23を参照してください)。図 24に示すように、Program Partウィンドウが
表示されます。 

図 23. Program Partオプション 

 

6. Program Partウィンドウで、以下を行ってください。 

a) Connectボタン (Port Selectionフィールドの隣にある) をクリックしてデバイスに接続します。 

b) MiniProg がデバイスへ電源を供給していて、デバイスへの電源を一旦切ってすぐに入れなおすことでデバイス
を選択する場合、Acquire Mode を Power Cycle に設定します。これは初期設定のオプションです。この 

プロジェクトでは、初期設定のオプションを使用します。 

c) デバイスが外部から電源供給されていて、MiniProg がデバイスをリセットすることでのみデバイスを選択できる

場合は、Acquire Modeを Resetに設定します。 
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7. Programボタンを押して、図 24のようにデバイスをプログラムします。 

図 24. プログラミングの状態 

 

8. プログラミングが完了した後、Powerボタンを押してデバイスの電源を切り替えます。これで、プログラマは基板の電源を

供給します。LED点滅と退色を観察します。 

 

7.7 CY3210-PSoCEval1基板の設定 

こ の デ モ は CY3210-PSoCEval1 ハ ー ド ウ ェ ア と 互 換 性 が あ り ま す 。 こ の キ ッ ト に 関 す る 詳 細 は 、

http://www.cypress.com/documentation/development-kitsboards/cy3210-psoceval1をご覧ください。 

図 25. CY3210-PSoCEval1キット 
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CY3210-PSoCEval1 キットをコンフィギュレーションしてプログラムする手順は以下の通りです。このキットには MiniProg や

ICE-Cubeなどのプログラミング デバイスが必要であることに注意してください。 

1. デモ基板にケーブルが一切接続されていない状態で、J1、J2 および J3 にはケーブルが差し込まれていないことを確認

します。  

2. P0[1]と VR 間を 1 本のワイヤで、P1[2]と LED1 間を 1 本のワイヤで接続し、P1[3]と LED2 間をもう 1 本のワイヤで

接続します (図 26を参照してください)。 

図 26. CY3210-PSoCEval1のピン接続 

 

     

3. 基板に搭載されているデバイスが CY8C29466-24PXIであることを確認します。 

4. 基板に電源を供給するためには、MiniProg 1／MiniProg 3 をプログラミング ヘッダー (J11) に接続します。同様に、

12Vの DC電源をキット上の J10に接続します。または、9Vバッテリを J12に接続することもできます。また、プログラミ

ング デバイスを J11に接続します。外部の電源や電池を使用する場合ではリセット モードを使用します。基板の接続は

図 27に示します。 

図 27．電源とプログラム接続 

 

http://www.cypress.com/
http://www.cypress.com/?rID=2541


================ 

 

PSoC
®
 1入門 

 

_________________________________________________________________________________________________________________ 
 

 www.cypress.com 文書番号: 001-79363 Rev. *D 25 

7.8 CY8CKIT-001ボードの設定 

CY8C29x66 プロセッサ モジュール 1 個を使用すると、このデモは CY8CKIT-001 ハードウェアとも互換性があります。この

キットに関する詳細は、http://www.cypress.com/?rID=37464をご覧ください。 

CY8CKIT-001 キットをコンフィギュレーションしてプログラムする手順は以下の通りです。このキットには MiniProg や ICE-

Cube などのプログラミング デバイスが必要であることに注意してください。さらに、このキットは ICE-Cube を使用する際に

オンチップ デバッグをサポートします。  

図 28. CY8CKIT-001キット 

 

1. デモ基板に一切ケーブルが接続されていない状態で、表 6のようにジャンパを設定して開発基板をコンフィギュレーション

します。 

表 6. ジャンパの設定 

ジャンパ 設定 

VDD選択 (SW3)  5V (上の位置) 

5Vソース (J8)  VREG (上ピン 2本) 

VDDデジタル (J7)  VDD (上ピン 2本) 

VDDアナログ (J6)  VDD (上ピン 2本) 

LCD電源 (J12)  ON (下ピン 2本) 

VDDIO選択 (J2～J5)  VDD (左上ピン 2本) 

 

2. P0[1]と VR 間を 1 本のワイヤで、P1[2]と LED1 間を 1 本のワイヤで接続し、P1[3]と LED2 間をもう 1 本のワイヤで

接続します (図 29を参照してください)。 
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図 29. 別のピン接続図 

 

 

3. MiniProgや ICEなどのプログラミング デバイスを PSoC 1プロセッサ モジュールの J5に接続します。  

4. 12V DC 電源か 9V バッテリから基板へ電源を供給するか、またはプログラマからの電源を使用します。外部の電源や

電池を使用すると、リセット モードが使用されたことを確認してください。基板の接続については、図 30を参照してください。 

図 30. 電源とプログラム接続 
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アプリケーションのテストにいずれの開発キットを使用した場合でも、以下を確認することが可能です。 

1. LCDディスプレイが「Hello World」と「ADC INPUT:----mV」を表示します。  

2. 1個の LEDが速く点滅します。 

3. 2個目の LEDは、徐々に高くなり低くなる明度でパルスを発します。  

8 まとめ  

本アプリケーション ノートは PSoC 1アーキテクチャおよび開発ツールを紹介しました。本書はまた、PSoC 1プロジェクトを開

始するのに必要なツールについて説明しました。PSoC 1 は、単一のチップにコンフィギュレーション可能なアナログとデジタル 

ペリフェラル機能、メモリ、M8Cマイクロコントローラーを集積している真のプログラマブル組み込みシステムオンチップです。  

本アプリケーション ノートはまた、PSoC 1を迅速に深く理解できるように総合的なリソース収集へのアクセスを提供します。 

説 明 し た 項 目 の 詳 細 情 報 に つ い て は 、 記 載 さ れ た リ ン ク や 参 照 文 献 を 参 照 す る 、 ま た は

http://www.cypress.com/products/psoc-1を訪問してください。 

9 関連アプリケーション ノート 

本アプリケーション ノートは PSoC 1 の基本的な情報を含んでいます。特定のトピックに関する詳細情報については、特定の

アプリケーション ノートを参照してください。 

 入門 

AN54181 - Getting Started with PSoC 3 

AN79953 – Getting Started with PSoC 4 

AN77759 - Getting Started with PSoC 5LP  

 アナログ 

AN2219 - PSoC® 1 Selecting Analog Ground and Reference 

AN74170 – PSoC 1 Analog Structure and Configuration with PSoC Designer
TM

 

AN13666 - PSoC® 1 Driving Analog Buffer Output to the Rail 

AN2096 - PSoC® 1 - Using the ADCINC Analog to Digital Converter 

 スイッチト キャパシタ ブロック 

AN2041 – Understanding PSoC 1 Switch Capacitor Analog Blocks  

AN2168 – PSoC 1 Understanding Switched Capacitor Filters 

AN16833 - Signal Mixing with PSoC® Switched Capacitor Blocks 

 GPIO 

AN2094 - PSoC® 1 - Getting Started with GPIO 

 プログラミング 

AN44168 - PSoC® 1 Device Programming using External Microcontroller (HSSP) 

 デジタル 

AN2141 - PSoC® 1 Glitch Free PWM 

 フラッシュ 

AN2015 - PSoC 1 Reading and Writing Flash & E2PROM 

 I2C 

AN50987 – Getting Started with I2C in PSoC 1 

 SPI 

AN51234 - Getting Started with SPI in PSoC® 1 
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 スリープ モード 

AN47310 - PSoC® 1 Power Savings Using Sleep Mode 

 LCD  

AN56384 - PSoC® 1 Segment LCD Direct Drive 

AN2152 - PSoC® 1 Graphics LCD and PSoC® Interface 
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改訂履歴  

文書名: AN75320 - PSoC
®
 1入門  

文書番号: 001-79363 

版 ECN番号 変更者 発行日 変更内容 

** 3620170 HZEN 05/17/2012 これは英語版 001-75320 Rev. **を翻訳した日本語版 001-79363 Rev. **です。 

*A 3889056 HZEN 01/29/2013 
これは英語版 001-75320 Rev. **を翻訳した日本語版 001-79363 Rev. *A です。 

1 ページの AN 番号のエラーを訂正しました。 

*B 4669800 HZEN 03/27/2015 これは英語版 001-75320 Rev. *D を翻訳した日本語版 001-79363 Rev. *B です。 

*C 4773026 HZEN 05/27/2015 変化なし日没 ECN ありません 

*D 5045452 HZEN 12/24/2015 これは英語版 001-75320 Rev. *Eを翻訳した日本語版 001-79363 Rev. *Dです。 
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サイプレスは、事業所、ソリューション センター、メーカー代理店および販売代理店の世界的なネットワークを保持しています。お客様

の最寄りのオフィスについては、サイプレスのロケーション ページをご覧ください。 
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